
THIS SPEC IS OBSOLETE

Spec No: 002-04463

Spec Title: AN204463 - SK-FM4-216-Ethernet Wi-Fi Sample
Kit Setup Manual

Replaced by: NONE



www.cypress.com Document No. 002-04463 Rev. *A 1

Contents
1 Contents of the Wi-Fi Module Sample Kit .................. 2

1.1 Evaluation Boards ............................................. 2

1.2 Contents of the Software Development Kit (SDK)4

2 Features of the Wi-Fi Module Sample Kit .................. 4

2.1 Features ............................................................ 4

2.2 Hardware Block Diagram .................................. 5

2.3 Software Block Diagram.................................... 5

3 How to Set Up the Wi-Fi Module Sample Kit ............. 6

3.1 Hardware Setup ................................................ 6

3.2 Software Setup.................................................. 8

3.3 Wi-Fi Connection............................................. 11

4 Wi-Fi Control and Commands.................................. 12

4.1 wifi_connect Command ................................... 12

4.2 wifi_disconnect Command .............................. 12

4.3 wifi_info Command.......................................... 13

4.4 wifi_on Command............................................ 13

4.5 wifi_off Command............................................ 13

4.6 wifi_ap Command ............................................13

4.7 wifi_scan Command.........................................13

4.8 wifi_get_rssi Command....................................13

4.9 wifi_promisc Command....................................14

4.10 wifi_simple_config Command ..........................14

4.11 wifi_wps Command..........................................14

4.12 wifi_sta_ap Command .....................................14

4.13 ttcp Command..................................................14

4.14 ping Command.................................................15

4.15 exit Command..................................................15

4.16 help Command.................................................15

5 Sample Application...................................................15

5.1 Web Server Application ...................................15

5.2 DHCP Server/client..........................................15

6 Additional Information...............................................15
Document History Page ...................................................16
Worldwide Sales and Design Support ..............................17

1 Contents of the Wi-Fi Module Sample Kit
The sample kit consists of evaluation boards and the software development kit (SDK).

■ The evaluation boards are the Cypress SK-FM4-216-ETHERNET and the Realtek Wi-Fi board.

■ The SDK is made up of both Cypress IP and Realtek IP. The SDK was created in an EWARM environment.

1.1 Evaluation Boards

1.1.1 SK-FM4-216-ETHERNET

The SK-FM4-216-ETHERNET supplies an S6E2CCAL0A MCU to represent the S6E2C Series.

Please refer to the URL http://www.cypress.com/documentation/development-kitsboards/fm4-216-ethernet-arm-
cortex-m4-mcu-development-kit-ethernet-can#DOCUMENTATION for detailed specification and functionality of
the SK-FM4-216-ETHERNET SDK.

Also, please refer to the document S6ECC Series datasheet (Document number: 002-04980) for detailed specifi-
cation and functionality of the S6E2CCAL0A MCU.

AN204463

SK-FM4-216-Ethernet Wi-Fi Sample Kit Setup Manual
Associated Part Family: SK-FM4-216-ETHERNET Series,

S6E2CC Series

This application note gives information about the SK-FM4-216-Ethernet Wi-Fi Module sample kit.

 

http://www.cypress.com/documentation/development-kitsboards/fm4-216-ethernet-arm-cortex-m4-mcu-development-kit-ethernet-can#DOCUMENTATION
http://www.cypress.com/documentation/development-kitsboards/fm4-216-ethernet-arm-cortex-m4-mcu-development-kit-ethernet-can#DOCUMENTATION
http://www.cypress.com/documentation/datasheets/s6e2c1-series-32-bit-arm-cortex-m4f-fm4-microcontroller
http://www.cypress.com
http://www.cypress.com/documentation/datasheets/s6e2c1-series-32-bit-arm-cortex-m4f-fm4-microcontroller
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Figure 1. SK-FM4-216-ETHERNET 

1.1.2 Wi-Fi Board

The Realtek Wi-Fi board using RTL8189EM is equipped with an SDIO/GSPI interface for MCU connectivity.

Please refer to the RTL8189EM datasheet for the detailed specification and functionality of the RTL8189EM.

Figure 2. Realtek Wi-Fi Board with RTL8189EM

 



SK-FM4-216-Ethernet Wi-Fi Sample Kit Setup Manual

www.cypress.com Document No. 002-04463 Rev. *A 3

1.2 Contents of the Software Development Kit (SDK)
The SKD contains four projects. The basic project is spansion_s6e2cc_8189em_without_ota.

The other projects are used for using the Over the Air Dual Bank eFlash (OTA-D) function.

Note that this document explains only the setup of spansion_s6e2cc_8189em_without_ota.

If you want to know about the use of projects for OTA-D, please refer to the application note for OTA-D for the
S6E2xC Series of MCUs (AN709-00008).

Figure 3. Basic Project Structure 

v02.5a … Package
├─component
│  ├─common
│  │  ├─api … Application interface
│  │  ├─drivers … WLAN driver
│  │  ├─file_system … empty
│  │  ├─network … Network relation
│  │  ├─ota … OTA-D Library
│  │  └─utilities … Utility applications
│  ├─os … FreeRTOS
│  └─soc … MCU(FM4F) relation
├─doc … Documents
├─project
│  ├─spansion_bootloader     … Bootloader project for OTA-D
│  ├─spansion_ota        … Binary project for OTA-D
│  ├─spansion_s6e2cc_8189em_with_ota … Sample user application project with
OTA-D
│  └─spansion_s6e2cc_8189em_without_ota … Sample user application project without
OTA-D
└─tools
    ├─ota_server … OTA-D Server
    ├─simple_config … Wi-Fi connection application for smartphone
    └─PCATTCP.exe … Tool for test TCP

2 Features of the Wi-Fi Module Sample Kit

2.1 Features
■ Wi-Fi chip — Realtek RTL8189EM 2.4 GHz IEEE 802.11b/g/n SISO

■ MCU on the SK-FM4-216-ETHERNET — S6E2CCAL0A Cortex-M4F 200 MHz embedded 256KB RAM, 2MB 
flash

■ Interface — Serial (UART, IC, SPI) , GPIOs, JTAGs

■ Software

❐ RTOS: FreeRTOS ver.7.4.0 as OSS

❐ (AP)/(Station) dual mode

❐ Built in Wi-Fi security support for WPA, WPA2

❐ LwIP for TCP/IP stack for IPv4 ver.1.3.1 as OSS

❐ Built-in DHCP server/client

❐ PolarSSL for SSL client ver.1.3.3 as OSS

❐ Enabled to build in application utilities 
test TCP, Ping, Web server, Over The Air Dual Bank eFlash (OTA-D)
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2.2 Hardware Block Diagram

Figure 4. Block Diagram of Sample Kit

2.3 Software Block Diagram

Figure 5. Software Stack
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3 How to Set Up the Wi-Fi Module Sample Kit
This section contains two parts:

■ Hardware setup: Connecting the SK-FM4-216-ETHERNET and the Wi-Fi board.

■ Software setup: Installing the firmware without OTA-D to the flash of a microcontroller.

3.1 Hardware Setup

3.1.1 Operating Environment (for Reference)

IDE: EWARM ver 6.70

ICE: I-Jet, J-Link, and J-Link-Lite

Laptop:

■ Windows 7

■ 2.5 GHz of CPU clock

■ 4.0 GB RAM

3.1.2 Hardware Connection

In this section, we explain how to connect the SK-FM4-216-ETHERNET to the Wi-Fi board.

1. Set the jumpers of the SK-FM4-216-ETHERNET to the default setting.

Please refer to the users guide for SK-FM4-216 Ethernet for details of the default settings.

2. Connect the SK-FM4-216-ETHERNET board to the Wi-Fi board through DuPont cables.

3. Connect the USB port (X-2 of Figure 6) for virtual com port of the SK-FM4-216-ETHERNET to your laptop.

4. Configure the serial connection terminal emulator (Tera Term or Hyper-terminal) on your laptop with the follow-
ing parameter.

Port: COMx

Bits: 115200

■ Data bits: 8

■ Parity Check: none

■ Stop: 1

■ Data flow control: none

K-FM4-216-ETHERNET Pin Pin Name SPI Wi-Fi Module Pin

J5-127 SIRQ 1

— NC 2

J4-97 MOSI 3

J4-108 GND 4

J5-109 VD33 5

J4-98 CLK 6

J5-136 GND 7

J4-96 MISO 8

J4-100 CS 9
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Figure 6. Connectors of the SK-FM4-S16-ETHERNET

Figure 7. Connectors of the Wi-Fi Module
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3.1.3 How to Turn on the Board

To turn on the Wi-Fi Module:

■ SK-FM4-216-ETHERNET: power supplied by AC adapter, USB or JTAG.

Notes: 

■ There is the setting of jumpers at each kind of power supply.

■ Please refer to the users guide for the SD-FM4-216-ETHERNET for jumper settings.

❐ Using the AC adapter

Supply voltage is 9–24 V.

Power switch is S2.

❐ Using USB 

Connecting a USB cable to the X12 port. (Because the operation will become unstable, don’t supply the 
power using the X2 port.)

Note: 

■ Jumper settings are different at each connected port.

❐ JTAG

Ensure that the adapter is able to provide enough current for your application.

■ Wi-Fi board: power supplied from the SK-FM4-216-ETHERNET via a DuPont cable.

3.2 Software Setup
In this section, we explain how to build and download the built code.

1. Open IAR Workbench.

2. To open project, [File] → [Open] → [Workspace]. 

Figure 8. Step 2 of Software Setup
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3. Select Project.eww in 

project\spansion_s6e2cc_8189em_without_OTA-D\EWARM-RELEASE

4. To build the project, [Project] → [Rebuild All]

Note: 

■ Make sure the sample project built successfully without errors.

Figure 9. Step 4 of Software Setup
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5. To download the built code, [Project] → [Download] → [Download active application]

Note: 

■ You can verify that the code successfully downloaded into the SK-FM4-216-ETHERNET board by 
checking the screen below. 

Figure 10. Step 5 of Software Setup

 

 



SK-FM4-216-Ethernet Wi-Fi Sample Kit Setup Manual

www.cypress.com Document No. 002-04463 Rev. *A 10

3.3 Wi-Fi Connection
1. Reset the SK-FM4-216-ETHERNET.

Push the reset button

2. Confirm serial output from the K-FM4-216-ETHERNET.

Serial output is as follows if operating correctly.

Figure 11. Serial Output of Startup

3. Connect to the Wi-Fi module sample kit from your laptop.

Default SSID of Wi-Fi module sample kit is wlan_ap_ssid.

Figure 12. Operation of Laptop
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4 Wi-Fi Control and Commands
The kit provides commands to control Wi-Fi from your laptop with serial communication.

The following is the description of built-in commands.

Note: 

■ Please refer to 4.2 section of the document UM0005 Realtek wlan init and configuration for the detailed 
description of commands.

4.1 wifi_connect Command
This command connects to the Wi-Fi network.

■ Syntax — wifi_connect[SSID][WPA2/WEP -password][WEP-key-ID]

■ Parameters

❐ [SSID]                           : Connection target.

❐ [WPA2/WEP-password]: Password of WPA2 or WEP.

❐ [WEP-key-ID]                : key ID for WEP.

If the WEP-key-ID parameter is omitted, the Wi-Fi module works in WPA2 security mode.

Also, if both the WEP-key-ID and WPA2/WEP-password are omitted, the Wi-Fi module works in open 
security mode.

4.2 wifi_disconnect Command
This command disconnects from the Wi-Fi network.

■ Syntax — wifi_disconnect

■ Parameters — Not required

Table 1.  Commands

Command Note

wifi_connect Connects to the access point.

wifi_disconnect Disconnects from the access point.

wifi_info Displays information about the Wi-Fi module.

wifi_on Initializes the Wi-Fi driver.

wifi_off Disables the Wi-Fi driver.

wifi_ap Switches the Wi-Fi module from Station mode to AP mode.

wifi_scan Displays the Wi-Fi (Network) scan results

wifi_get_rssi Displays the received signal strength indicator value.

wifi_promisc Displays result returned on the Promiscuous mode of the Wi-Fi driver.

wifi_simple_config Connects with the Android or iOS device that is installed with the dedicated application.

wifi_wps Shifts the Wi-Fi module to WPS Connecting mode.

wifi_sta_ap Switches Wi-Fi module to Station mode and AP mode concurrently.

ttcp Measures throughput.

Ping Sends ping packets.

Exit Closes the interface of serial commands.

Help Displays usable commands.
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4.3 wifi_info Command
This command displays the following status of the Wi-Fi driver.

■ Wi-Fi setting status — Wi-Fi mode, SSID, Security mode, password, MAC, IP, GW address

■ Wi-Fi running status — Free space of heap size, usage of the socket buffer, number of the using timer

■ Syntax — wifi_info

■ Parameters — Not required

4.4 wifi_on Command
This command initializes the Wi-Fi driver.

After the Wi-Fi driver is initialized, the Wi-Fi module will work in Station mode.

■ Syntax — wifi_on

■ Parameters — Not required

4.5 wifi_off Command
This command disables the Wi-Fi driver.

Also, this command triggers disconnection from a Wi-Fi network.

■ Syntax — wifi_off

■ Parameters — Not required

4.6 wifi_ap Command
This command switches the Wi-Fi module from Station mode to AP mode.

■ Syntax — wifi_ap [SSID] [Channel] [WPA2-password]

■ Parameters

❐ [SSID]                  : SSID of AP mode.

❐ [Channel]             : Channel number is 1 to 13.

❐ [WPA2-password]: Password for WPA2.

If the WPA2-password is set, the Wi-Fi module works in WPA2 security mode.

If the WPA2-password is omitted, Wi-Fi module works in open security mode.

4.7 wifi_scan Command
This command scans the AP list.

■ Syntax — wifi_scan [Buffer_length]

■ Parameters

❐ [Buffer_length]: Buffer length for AP list.

Note: 

■ Default recommended value is 500.

4.8 wifi_get_rssi Command
This command gets the RSSI value from the Wi-Fi driver.

■ Syntax — wifi_get_rssi

■ Parameters — Not required
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4.9 wifi_promisc Command
This command makes the Wi-Fi driver run in Promiscuous mode and gets the result of Promiscuous mode.

Promiscuous mode moves all channels (1 to 13) and gets promiscuous packets.

■ Syntax — wifi_promisc [Duration]

■ Parameters

❐ [Duration]: Time stayed in each channel. [second]

4.10 wifi_simple_config Command
This command connects the android base dedicated application that is placed SimpleConfigApp.apk in tools/sim-
ple_config/Android.

Please refer to the document AN0011 Realtek WLAN Simple Configuration in /doc for using this application.

■ Syntax — wifi_simple_config [PIN-code]

■ Parameters

❐ [PIN-code]:The dedicated application for android requires PIN-code.

PIN-code is set on the Android application.

4.11 wifi_wps Command
This command initiates the connection for WPS.

■ Syntax — wifi_wps [Config_method]

■ Parameters

❐ [Config_method]: Configurable method is pin or pbc.

pin: The connection by PIN-code.

pbc: The connection by push button.

4.12 wifi_sta_ap Command
This command switches the Wi-Fi module to Coexistent mode of Station and AP.

■ Syntax — wifi_sta_ap [SSID] [Channel] [WPA2-password]

■ Parameters

❐ [SSID]:SSID of AP mode.

❐ [Channel]:This channel number is used on AP mode of the Wi-Fi module.

❐ [WPA2-password]:Password for WPA2.

If the WPA2-password is set, the Wi-Fi module works WPA2 security mode.

If the WPA2-password is omitted, the Wi-Fi module works open security mode.

4.13 ttcp Command
This command runs the throughput test for Rx/Tx.

■ Syntax — ttcp [Mode] [Size] [Count] [Dest_addr]

■ Parameters

❐ [Mode]        : ttcp running mode is r, t, rt, or tr

r: Reception mode.

t: Transmission mode.

rt and tr: Reception and Transmission mode at the same time.

❐ [Size]          : Sending packet size

❐ [Count]       : Count of sending packet

❐ [Dest_addr]: Destination IP address for IPv4

Note: 

■ If mode is r, Count and Dest_addr parameters must be omitted.
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4.14 ping Command
This command sends ping packets.

■ Syntax — ping [Dest_addr] [Count]

■ Parameters

❐ [Dest_addr]: Destination IP address for IPv4

❐ [Count]       : Count of sending ping packet

Note: 

■ If the Count parameter is omitted, ping packet is sent five times.

4.15 exit Command
This closes the interface of serial commands.

■ Syntax — exit

■ Parameters — Not required

4.16 help Command
This command gets the usable command list.

■ Syntax — help

■ Parameters — Not required

5 Sample Application

5.1 Web Server Application
Please refer to the document UM0014 Realtek web server user guide for detailed description of commands.

5.2 DHCP Server/client
DHCP server and client are enabled at default setting of the sample kit.

If you want to disable the DHCP server and client, please refer to the document UM0005 Realtek wlan init and
configuration.

6 Additional Information
For more information on Cypress products, please visit the following website: 

http://www.cypress.com/cypress-microcontrollers

 

http://www.cypress.com/cypress-microcontrollers
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